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About the Machine

Features

This machine is a hot stamping printer that uses laser light. Using foil to imprint illustrations and text results in 
high-class decorations on plastic products.
You can easily create imprint data using dedicated software.

Names of Components

Machine

Power-cord 
connector

USB connector

Cover

Head

Base table

Head unit

Power/Movement button

Laser pointer

Lock lever

Laser unit
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Head

The foil is transferred onto the material by way of the laser light irradiated from the lens. Because the 
lens is a consumable part, replace it at the appropriate time.

	" P.50  "Checking the Lens Service Life"

Lens

Material Retainers

Material retaining frames

These frames secure thick material in place by clamping it. The orientation in which the frames are 
secured can be changed to match the width of the material.

Knob (large)

Raising table

This table is installed on top of the base table to enable imprinting even on thin material by raising it.

Head detection holes

About the Machine
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Light-absorbing Film

Striking the light-absorbing film with the laser light converts the light into heat. Note that if the film is installed 
with its front and back sides inverted by mistake, it will not be possible to convert the light to heat, so imprinting 
will not be performed. For details, see P.51  "Replacing the Light-absorbing Film".

This heat transfers the foil onto the material.

A
A Material

Laser light

Foil

Light-absorbing film

Film frame

An adhesive sheet adhered to the bottom of the film retainer is used to secure the light-absorbing film.

Film frame

About the Machine
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Head Detection Jig

These jigs are used to detect the head. There are two types of jigs: a high one and a low one. Use these 
jigs according to the thickness of the material.

About the Machine
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Basic Operation

Switching On the Power

Procedure

Press the [Power/Movement] button.
The head moves to the back left corner, and the lamp of the Power/Movement button is turned ON. 
This operation is called initialization.

Important: When the power lamp remains blinking
An initialization error has occurred. Refer to the following section to eliminate the cause of the error, and then 
press the [Power/Movement] button again.

	" P.88  "The [Power/Movement] Button Is Blinking"

Switching Off the Power

Procedure

Hold down the [Power/Movement] button for 1 second or longer.

The light turns off and the power is switched off.

9Chapter 1 Getting Started



Starting the Software

Windows 11

1	Click the [Start] button.

2	From the [All apps] window, click the icon for [(Name of software to use)] under the 
[(Name of software to use)] folder.

Windows 10

1	Click the [Start] button.

2	Click the icon for [(Name of software to use)] under the [(Name of software to use)] 
folder.

How to Display Help for the Software

Start the software, and then click [Help] - [Contents] from the menu.

	" P.10 "Starting the Software"

Basic Operation
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Checking Imprint Workflow

P.16  "Specifying Output Destination for METAZAStudio"

Switch on the power of the machine and select it as the output destination for the computer.

P.17  "Preparing the Material"

Check several conditions such as the material type and thickness that must be met for a material to be imprinted.

P.20  "Loading the Material (Material Thickness: 0 to 26 mm)"

P.22  "Loading the Material (Material Thickness: 24 to 50 mm)"

P.26  "Loading the Material (Material Thickness: 50 to 216 mm)"

Set the material on the machine.

P.32  "Creating Imprint Data"

Create imprinting data using METAZAStudio.

P.39  "Imprinting"

Output the imprint data from METAZAStudio.

Preparing for Imprinting
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Starting METAZAStudio

Windows 11

1	Click the [Start] button.

2	From the [All apps] window, click the icon for [METAZAStudio] under the [Roland 
METAZAStudio] folder.

Windows 10

1	Click the [Start] button.

2	Click the [METAZAStudio] icon under the [Roland METAZAStudio] folder.

METAZAStudio starts.

Preparing for Imprinting
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METAZAStudio Screen

No. Name Overview of function

1 Menu bar
Runs the various commands for METAZAStudio.

	" METAZAStudio online help ("Commands")

2 Toolbar
The toolbar is provided with buttons for running METAZAStudio commands such 
as [Material] and [Open].

	" METAZAStudio online help ("Commands" - "Toolbar Buttons")

3 Page feed bar

When you have entered data into a variable field, use this to specify the page 
(record) that is displayed on the screen. Use this for variable imprinting.

	" P.77  "Creating Variable Imprint Data"

	" METAZAStudio online help ("Hints and Tips" > "Performing Variable Printing")

4 Status bar

This shows the present location of the cursor, information about the shape, the 
grid, and the view magnification. Moving the pointer to a toolbar button or pointing 
to a menu command makes a brief explanation of the button or command appear 
at the left edge.

Present cursor 
position

This indicates the present location of the cursor. The 
position at the center of the window (where the two 
center lines intersect) is (0, 0).

Shape information

This appears when you click an on-screen object 
(image, text, or shape). The center position and size 
of the present shape are displayed, as shown in the 
figure below.

Grid pitch
This displays the pitch (spacing) of the grid lines. 
Clicking this displays menu items related to the 
appearance of the grid.

View scaling factor
This displays the present scaling factor for the screen 
view. Clicking this displays a menu that lets you 
change the view scaling factor.

Preparing for Imprinting

14 Chapter 2 Imprinting



11

No. Name Overview of function

5 Work area
This is the area in which the laser can move. The material size set with LD 
Driver is shown here.

	" P.84  "Changing Basic Driver Settings"

6
LP movement 
possible area

You can move the laser pointer within this range.

7
LP movement not 
possible area

Do not move the laser pointer within this area. If you attempt to do so, laser 
irradiation may occur in an unexpected position.

8 Center line This indicates the vertical and horizontal centers of the window.

9 Grid This is a grid of lines displayed in the work area. It serves as a guide for 
positioning images and text.

0 Margin

This blank area lies inside the edges of the work area and where no imprinting 
is performed. The default setting upon installation of METAZAStudio is 2 mm 
(0.08 in.). You can change the size of the margin by going to the [File] menu 
and selecting [Preferences].

	" P.32  "Step 1: Prepare to Create Imprint Data"

A
Head detection 
position

Perform operations within the window to display the head detection jig in the 
same position as that where it is attached to the machine (back left corner/
front right corner).

	" P.40  "Making Imprints"

Preparing for Imprinting
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Specifying Output Destination for METAZAStudio

Procedure

A	Switch on the power to the machine.

	" P.9  "Switching On the Power"

B	Start METAZAStudio.

	" P.13  "Starting METAZAStudio"

C	Click [File] → [Set up the printer].

The [Print Setup] screen appears.

D	Select the printer to which data will be output.

1	Select [DGSHAPE LD-300].

2	Click [OK].

Preparing for Imprinting
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Preparing the Material

In order for a material to be used for imprinting with this machine, the material must meet all of the following 
conditions.

Material

•	 Acrylic

•	 Polypropylene

•	 Polystyrene

•	 ABS

•	 Leather

•	 Polyurethane

•	 Vinyl chloride

Thickness

Maximum: 216 mm (8.5 in.)

Size

Width: Maximum 323 mm (12.72 in.)

Size that can be stably fixed in place.

With this machine, use the adhesive sheet and retainers to secure the material. It is acceptable for the material to 
be of a size such that it protrudes from the adhesive sheet and retainers, but the essential requirement is that the 
material can be firmly secured within the main unit.

When using the raising table: A material size such that one of the head detection holes is not covered

Head detection holes

When not using the raising table: A material size such that the head detection jig can be attached correctly

Preparing for Imprinting
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Shape

There must be no unevenness on the imprint surface.

Imprinting is not possible for material that comes into contact with the moving part of the machine when 

being loaded or during imprinting.

The edge of the 
material is too high.

Not OK

L-shape

Flat view:

Cross-sectional 
view:

Gentle undulations of less than 0.5 mm (0.02 in.)

If the height displacement cannot be tracked by the head, correct imprinting will not be possible.

Preparing for Imprinting
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Securing the Material

Selecting How to Secure the Material

The securing method varies according to the thickness of the material. Standards are shown below.

Material

D

Material
D

C

B
Material

B

Material
A

Material 
thickness Securing method

Place the included raising table on the base table, 
and then fix the material in place.

 " P. 20 “Loading the Material (Material Thickness: 0 to 

26 mm)”

I tems used

•	 Raising table A

•	 Base table B

Fix the material in place on the base table.
 " P. 22 “Loading the Material (Material Thickness: 24 to 

50 mm)”

I tems used

•	 Base table B

Remove the base table, and then fix the material in 
place with the material retaining frames.

 " P. 26 “Loading the Material (Material Thickness: 50 to 

216 mm)”

I tems used

•	 Height adjusting block C

* This is not included. Prepare it separately.
•	 Material retaining frames D

Remove the base table, and then fix the material in 
place with the material retaining frames.

 " P. 26 “Loading the Material (Material Thickness: 50 to 

216 mm)”

I tems used

•	 Material retaining frames D

0 mm

24 mm 
(0.9 in.)
26 mm 

(1.0 in.)

50 mm 
(2.0 in.)

190 mm 
(7.5 in.)

216 mm 
(8.5 in.)

Memo: When the thickness of the material is 24 to 26 mm (0.9 to 1.0 in.)
When imprinting is frequently performed on material whose surface is soft or whose thickness is less than 26 mm 
(1.0 in.), use the raising table.

	" P. 20 "Loading the Material (Material Thickness: 0 to 26 mm)"
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Loading the Material (Material Thickness: 0 to 26 mm)

Procedure

A	Open the cover.

B	Load the raising table on the base table.
Insert the positioning pins on the bottom of the raising table into the holes on the upper surface of the 
base table.

Raising table

Hole

Positioning pins

C	Set the adhesive sheet.
If the material is large, use two adhesive sheets.

Securing the Material
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D	Load the material.

How to Place Material
•	 If the material is too large to fit on the table, use supports to keep the material 

horizontal.
•	 Gently press the material as if affixing it to the adhesive sheet.

Load material having a thickness of less than 14 mm (0.55 in.) such that either detection 
hole can be seen.

Select the loading position according to the detection hole to be used.

Head detection hole 
(back left corner)

Head detection hole 
(front right corner)

Set the selected head detection hole position in the METAZAStudio window.

Right-click in the METAZAStudio window and click [Head position detection] - [Back left corner] or 
[Front right corner] to set the head detection hole position.

Load material having a thickness of 14 mm (0.55 in.) or more such that the head detection 
hole in the back left corner can be seen.

Detecting the head with the hole in the front right corner will lead to interference from the head, so use 
the head detection hole in the back left corner to detect the head.

Head detection hole (back left corner)

Set the selected head detection hole position in the METAZAStudio window.

Right-click in the METAZAStudio window and click [Head position detection] - [Back left corner] to set 
the head detection hole position.

Securing the Material
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Important!

Remove dirt and dust from the imprint surface.

Performing imprinting without removing dirt and dust attached to the imprinting surface may decrease the 
imprint quality.

This completes the procedure for loading the material.

	" P.32  "Creating Imprint Data"

Loading the Material (Material Thickness: 24 to 50 mm)

Procedure

A	Open the cover.

B	Right-click in the upper-right corner of the METAZAStudio window and click [Move LP here].
The head moves to the back right corner.

Right-click in the upper-right 
corner of the window.

Securing the Material
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C	Loosen the (small) knob on the back left corner.

Knob (small)

D	Select the head detection jig.
Select the head detection jig to use according to the thickness of the material.

Material thickness Head detection jig to use
24 to 36 mm 
(0.95 to 1.42 in.)

Low

Thicker than 36 mm 
(1.42 in.)

High

Important: Use the head detection jig with the correct height.
If you use the incorrect jig, the head will strike the material, leading to defective imprinting and part damage.

E	Lower the head detection jig so that its slit sits on the (small) knob.

Slit

Securing the Material
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F	Tighten the (small) knob.
Fix the jig in place while pressing it straight down onto the base table.

Knob (small)

Set the selected head detection hole position in the METAZAStudio window.

Right-click in the METAZAStudio window and click [Head position detection] - [Back left corner] to set 
the head detection hole position.

G	Set the adhesive sheet on the top of the base table.
If the material is large, use two adhesive sheets.

H	Load the material.

How to Place Material
•	 If the material is too large to fit on the table, use supports to keep the material horizontal.
•	 Gently press the material as if affixing it to the adhesive sheet.

Important!

Remove dirt and dust from the imprint surface.

Performing imprinting without removing dirt and dust attached to the imprinting surface may decrease the 
imprint quality.

This completes the procedure for loading the material.

	" P.32  "Creating Imprint Data"

Securing the Material
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When Fixing the Head Detection Jig in Place in the Front Right Corner

If you cannot fix the head detection jig in place in the back left corner (such as when loading a workpiece in the 
back left corner of the table), fix this jig in place in the front right corner.

1	Loosen the (small) knob on the front right corner.

Knob (small)

2	Lower the head detection jig so that its slit sits on the (small) knob.

Slit

3	Tighten the (small) knob.
Fix the jig in place while pressing it straight down onto the base table.

Knob (small)

Securing the Material
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Set the selected head detection hole position in the METAZAStudio window.

Right-click in the METAZAStudio window and click [Head position detection] - [Front right 
corner] to set the head detection hole position.

Loading the Material (Material Thickness: 50 to 216 mm)

If the material thickness is 50 to 190 mm (2.0 to 7.5 in.), prepare a separate height adjusting block.
Ensure that the height of the imprinting surface from the base of the machine ("material 
thickness + height adjusting block") is 190 mm (7.5 in.) or more.

Material thickness

Height adjusting block height

Imprinting 
surface

Procedure

A	Open the cover.

Securing the Material
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B	Remove the base table.

C	Set the adhesive sheet on the base of the work area.
If the material is large, use two adhesive sheets.

Adhesive sheet

D	Right-click in the upper-right corner of the METAZAStudio window and click [Move LP 
here].
The head moves to the back right corner.

Right-click in the upper-right 
corner of the window.

Securing the Material
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E	Loosen the (small) knob on the back left corner.

Knob (small)

F	Select the head detection jig.
Select the head detection jig to use according to the height of "material thickness + height adjusting block."

Material thickness +  
height adjusting block

Head detection jig to use

190 to 201 mm  
(7.5 to 7.9 in.)

Low

Higher than 201 mm  
(7.9 in.)

High

Important: Use the head detection jig with the correct height.
If you use the incorrect jig, the head will strike the material, leading to defective imprinting and part damage.

G	Lower the head detection jig so that its slit sits on the (small) knob.

Slit

Securing the Material
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H	Tighten the (small) knob.
Fix the jig in place while pressing it straight down onto the table.

Knob (small)

Set the selected head detection hole position in the METAZAStudio window.

Right-click in the METAZAStudio window and click [Head position detection] - [Back left corner] to 
set the head detection hole position.

I	If the material thickness is 50 to 190 mm (2.0 to 7.5 in.), place a height adjusting block in 
the center of the workspace.

J	Load the material.

Important!

Remove dirt and dust from the imprint surface.

Performing imprinting without removing dirt and dust attached to the imprinting surface may decrease the 
imprint quality.

Securing the Material
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K	Set the material retaining frames to match the width of the material, and then tighten the 
(large) knobs.
Check that the material is fixed in place.

Wide material

Knob (large)

Narrow material

Knob (large)

This completes the procedure for loading the material.

	" P.32  "Creating Imprint Data"

When Fixing the Head Detection Jig in Place in the Front Right Corner

If you cannot fix the head detection jig in place in the back left corner (such as when loading a workpiece in the 
back left corner of the table), fix this jig in place in the front right corner.

1	Loosen the (small) knob on the front right corner.

Knob (small)

Securing the Material
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2	Lower the head detection jig so that its slit sits on the (small) knob.

Slit

3	Tighten the (small) knob.
Fix the jig in place while pressing it straight down onto the table.

Knob (small)

Set the selected head detection hole position in the METAZAStudio window.

Right-click in the METAZAStudio window and click [Head position detection] - [Front right 
corner] to set the head detection hole position.

Securing the Material
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Step 1: Prepare to Create Imprint Data

Procedure

A	Start METAZAStudio.

	" P.13  "Starting METAZAStudio"

B	Click .

The [Select Foil] screen appears.

C	Use the [Select Foil] screen to select the foil.
Clear the [Use printer driver settings] check box to select the foil. To use foil that is not included in the 
list, you can register the foil.

	" P.82  "Registering the Foil and Adjusting the Imprinting Power"

If you will use the LD Driver settings without changing them, select the [Use printer driver settings] 
check box.

D	Click [OK].

Creating Imprint Data
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E	Click [File] → [Preferences].

The [Preferences] screen appears.

F	Set the margins.

1	Set [Margin] to 2 mm (0.08 in.).

2	Click [OK].

Important!
To imprint a flat material, make the margin at least 2 mm (0.08 in.). If the margin is set to less than 2 mm (0.08 in.), 
the lens may strike the edge of the material, leading to lens damage.

Creating Imprint Data
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Step 2: Import the Image

Import an image to be imprinted.

Data Formats Supported by METAZAStudio

•	 JPEG format

•	 BMP (bitmap) format

•	 Files in AI or EPS format created with Illustrator version 7 or 8

•	 Files in AI or EPS format exported by CorelDRAW version 7 or 8

	* Illustrator and CorelDraw files are subject to a number of limitations. For details, see the online help for 

METAZAStudio.

	" METAZAStudio online help ("Hints and Tips" > "Reusing Existing Data")

Important: Photographs are not suitable for imprinting with this machine.

Import image and text data.

Procedure

A	Click .

The [Import] screen appears.

B	Open the file.

1	At [Look in], select the location of the file.

2	Under [Files of type], select either [Picture file] or [Adobe Illustrator file].

3	Select the file you want.

4	Click [Open].

 

Creating Imprint Data
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The specified image is imported and displayed with the margins you set.

Memo
You can vary the arrangement of the placed image such as by changing the size or orientation or by adding a 
border.

	" P. 58 "Processing Images"

Important!
If the material has holes, take care to ensure that the image is not laid out over the holes. If you include the holes 
in the imprint area, the lens might hit the edge of the material, leading to lens damage.

Imprint area Imprint area

Imprint area

Imprint area

The imprint area lies 
over a hole.

No margins are 
present at the edges 
of the material.

The area to be 
imprinted extends 
beyond the material.

OK Not OK

2 mm 
(0.1 in.)

2 mm 
(0.1 in.)

Creating Imprint Data
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Step 3: Enter Text

Type in the text to be imprinted.

Procedure

A	Click .

B	Enter text.

1	Click on the imprint area.

2	Enter text.
You can change the size and orientation of the typed text and fill it.

	" P. 63 "Tips and Tricks for Text Layout"

Creating Imprint Data

36 Chapter 2 Imprinting



Step 4: Match the Imprinting Position and Size

A	Close the cover of the machine.

B	Right-click the imprint data in METAZAStudio, and then click [Move LP to the top left 
corner of the object].
Laser pointer irradiation starts, and the laser pointer moves to the specified position.

Important!
If the [Move LP to the top left corner of the object] option is disabled, you have not selected a shape in 
the imprint data. Select, and then right-click a shape.

C	Check the position where the laser pointer irradiated the material.

D	Right-click the imprint data in METAZAStudio, and then click [Move LP to the bottom right 
corner of the object].
Laser pointer irradiation starts, and the laser pointer moves to the specified position.

E	Check the position where the laser pointer irradiated the material.
Check whether the upper-left and lower-right positions of the imprint data are contained within the 
bounds of the material.

F	If necessary, change the positions and size of the imprint data in METAZAStudio.

	" P. 59 "Adjusting the Location, Size, or Angle of an Image"

	" P. 63 "Changing the Location, Size, or Angle of Text"

G	Repeat steps B to F to make adjustments until you obtain the intended imprint positions.

Material

Laser pointer

Position to imprint

METAZAStudio

Laser pointer

Imprint data

Creating Imprint Data
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Important!
If you are using the same imprint data to continuously imprint on multiple materials or on the front and back of a 
material, you cannot use the laser pointer to adjust the positioning when setting the material again. Mark the 
position adjusted to the first time, use positioning pins, or employ a similar method to make it possible to set the 
material in the same position.

Positioning pins

Step 5: Save Imprint Data

Save the imprint data to a file.

Procedure

A	Click .

The [Save As] screen appears.

B	For [Save in], specify where to save the file.

C	Enter a file name.

D	Click [Save].

B

C

D

Creating Imprint Data
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Loading the Foil and the Light-absorbing Film

A	Right-click in the METAZAStudio window and click [Move head to the back left corner].

B	Place the foil on top of the material.

The foil has a front side and a back side.

Place the foil on the material such that the foil color that you want to imprint (the glossy surface) faces up.

C	Align the film frame supports with the holes in the table, and then insert these supports 
into these holes.

Raising table Base table Material retaining frames

Important: Affix the light-absorbing film to material covered with foil.

If the light-absorbing film is not affixed to the material, the foil will not be transferred successfully.

Important: Use the light-absorbing film while changing the location struck by the laser.

If you use the same location multiple times, the effect of converting light to heat will be reduced. Use 
the light-absorbing film by shifting its position so that unused locations are used. When there are no 
longer any unused locations, replace the light-absorbing film.

	" P.51  "A General Guide for the Service Life of the Light-absorbing Film"
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Making Imprints

After completing "Creating Imprint Data" and "Loading the Material," imprinting starts.

	" P.32  "Creating Imprint Data", P.17  "Preparing the Material"

Procedure

A	Check that the laser has been set to .

	" P. 81 "Adjusting the Imprinting Pressure"

Lever

B	Close the cover.

C	Right-click in the METAZAStudio window and click [Head position detection] - [Back left 
corner] or [Front right corner].

When using the raising table with a material having a thickness of 14 mm (0.55 in.) or more
Be sure to set the head detection position to the back left corner. Detecting the head with the front right 
corner position may lead to interference from the head.

Head detection hole (back left corner)

When using the raising table with a material having a thickness of less than 14 mm (0.55 in.)
Select the head detection position according to which head detection hole on the raising table you will use.

Head detection hole 
(back left corner)

Head detection hole 
(front right corner)

Imprinting
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When not using the raising table
Select the head detection position according to the actual position where the head detection jig is 
attached.

D	Click .
The [Print] screen appears.

E	Set and confirm the preferences below.

Printer name DGSHAPE LD-300

Foil Select the foil. The selection made when creating new imprint data is reflected in 
the foil setting.

Imprint range

Use this option mainly for variable imprinting. (Normally, [All] is selected.) To 
restrict records* to be imprinted, specify the records (pages) that you wish to 
imprint. For example, to imprint only the 2nd to 5th records, select [Pages] and 
specify from page "2" to page "5."

Copies
If imprinting the same material in multiple locations, specify the number of copies. 
For example, if you wish to imprint the front and back sides of the material, specify 
"2" as the number of copies.

	*  Record: This refers to individual data included in the data for variable imprinting.

	" P.77  "Creating Variable Imprint Data"

F	Click [OK].
Imprinting starts.

Imprinting
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Memo: Imprinting multiple copies or records
One of the following messages will be displayed when imprinting starts. Wait until imprinting is finished, 
and then go on to the next step.

 

Important: During imprinting, never open the cover.

If the cover is opened during imprinting, the imprinting will stop, which will make it impossible to imprint 
correctly.

G	When imprinting is finished, replace the material or change its orientation.

	" P.20  "Loading the Material (Material Thickness: 0 to 26 mm)"

	" P.22  "Loading the Material (Material Thickness: 24 to 50 mm)"

	" P.26  "Loading the Material (Material Thickness: 50 to 216 mm)"

Important!
If you are using the same imprint data to continuously imprint on multiple materials or on the front and back of a 
material, you cannot use the laser pointer to adjust the positioning when setting the material again. Mark the 
position adjusted to the first time, use positioning pins, or employ a similar method to make it possible to set the 
material in the same position.

Positioning pins

H	Close the cover.

I	Click [OK].
Imprinting of the next page starts.

Imprinting
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Variable Imprinting of Only the Displayed Records

Click .
The [Print] screen appears. The number (page number) of the record being displayed in 
METAZAStudio is specified as the page under [Print Range]. Specify [Foil] and [Copies] as necessary 
and click [OK] to start imprinting.

Imprinting
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Step 1: Stopping Imprinting Operations

A	Hold down the Power/Movement button for 1 second or longer.
The light slowly blinks while the transmitted imprint data is being deleted. The light turns off and the 
power is switched off.

Memo
When imprinting is paused, the head stays in the same position. The head will move to the back left corner the 
next time the power is switched on.

Stopping Imprint Operations
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Step 2: Deleting Data from the Imprint Queue

Procedure

A	Display the printer icon.

Windows 11

1	Click the [Start] menu on the computer.

2	Click [All apps], [Windows Tools], and then click [Control Panel].

3	Click [View devices and printers].

Windows 10

1	Click the [Start] menu on the computer.

2	Click [Windows System], and then click [Control Panel].

3	Click [View devices and printers].

B	Double-click the [DGSHAPE LD-300] icon.

C	From the [Printer] menu, click [Cancel All Documents] (or [Purge Print Documents]).

D	If the message shown in the figure appears, click [Yes].

Stopping Imprint Operations
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Points to Note on Daily Care

WARNING	 Never use gasoline, alcohol, thinner, or any other flammable material.
Doing so may cause a fire.

WARNING	 During repairs, part replacements, and similar work, never perform any opera-
tions that are not written in the user's manual.
Be sure to contact your authorized Roland DG Corporation dealer.

WARNING	 Perform this task with all power switches left switched off.
Failure to observe these instructions may cause the machine to move suddenly, 
resulting in injury.

•	 This machine is a precision device and is sensitive to dust and dirt. Be sure to carry out day-to-day cleaning.

•	 Never use solvents such as thinner, benzine, or alcohol.

•	 Never attempt to oil or lubricate the machine.

•	 Never apply silicone substances (oil, grease, spray, etc.) to the machine. Doing so may cause poor switch contact.

Cleaning the Machine

•	 Use a cloth moistened with water and wrung well, and wipe the parts gently to clean them.

•	 The surface of the cover is easily scratched, so use a soft cloth.

Cleaning the Adhesive Sheet

Buildup of dust or the like on the adhesive sheet can reduce the sheet's adhesive force, making it difficult to 
secure material in place. If the adhesive force has been reduced, wash the adhesive sheet.

Adhesive sheet

How to Wash

Immerse the adhesive sheet in water, and wash the sheet by gently stroking its surface. If the soiling of the 
adhesive sheet is severe, wash it using diluted neutral detergent. Rinse thoroughly with water to remove all 
detergent completely.

Important!
Be sure to comply with the following instructions. If not, the surface of the adhesive sheet may become damaged, 
lowering the adhesiveness.

•	 Never scrub the adhesive sheet using a scrubbing pad or sponge.

•	 Never stretch or bend the adhesive sheet when washing it.

Daily Care
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How to Dry

Allow the part to dry completely while keeping it out of direct sunlight.

Cleaning the Film Frame

Buildup of dust or the like on the film frame's adhesive sheet can reduce the sheet's adhesive force, making it 
impossible to secure the light-absorbing film in place. If the adhesive force has been reduced, wash the film 
frame's adhesive sheet.

Adhesive sheet

How to Wash

Immerse the adhesive sheet in water, and wash the sheet by gently stroking its surface. If the soiling of the 
adhesive sheet is severe, wash it using diluted neutral detergent. Rinse thoroughly with water to remove all 
detergent completely.

Important!
Be sure to comply with the following instructions. If not, the surface of the adhesive sheet may become damaged, 
lowering the adhesiveness.

•	 Never scrub the adhesive sheet using a scrubbing pad or sponge.

•	 Never stretch or bend the adhesive sheet when washing it.

How to Dry

Allow the part to dry completely while keeping it out of direct sunlight.

Daily Care
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Adjusting the Position of the Laser Pointer

With this machine, determine the imprinting position by viewing the irradiation position of the laser pointer 
linked with METAZAStudio. If the actual imprinting position is offset from the irradiation position of the laser 
pointer, adjust the irradiation position with the method shown below.

Procedure

A	Start LD-300 Head Manager.
	" P.10  "Starting the Software"

B	Click [Adjust LP Position].

The [Adjust LP Position] window is displayed.
Follow the on-screen instructions to perform adjustment.

	" P.91  "Laser Pointer Position Adjustment Failed (Head Manager)"

Material to prepare

•	 Material with a flat imprinting surface (material that is not curved)

•	 Material that can be imprinted with this machine

	" P.17  "Preparing the Material"

•	 Material with a size that contains the marker (30 mm × 30 mm [1.2 in. × 1.2 in.] or more)

C	When you have finished, click .
The window closes.

Adjusting
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Replacing Consumable Parts

Checking the Lens Service Life

The lens is a consumable part. When the lens has reached the end of its service life, replace it.

A General Guide for the Service Life of the Lens

The guideline for replacement is after approximately 500 hours of imprinting.
A message that indicates the lens service life appears in METAZAStudio.

Click [OK] to make the message disappear. Click [Details] to make LD-300 Head Manager appear.

How to Check the State of the Lens

You can check the state of the lens using LD-300 Head Manager.

Procedure

A	Start LD-300 Head Manager.
	" P.10  "Starting the Software"

B	Switch on the power to the machine.

	" P.9  "Switching On the Power"

The amount of lens usage is indicated in this window. The level 
indicator increases little by little as imprinting is performed.

This refreshes the screen to display the latest information.
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Memo
The indicator for [The amount of Lens usage] in LD-300 Head Manager shows how much the lens has 
been used. The lens should be replaced in the following cases.

•	 The indicator is shown in red.

•	 Although the indicator is not shown in red, attractive imprinting is impossible or images are uneven.

A worn-out lens is not the only reason for decreased imprint quality and uneven imprint results. Refer 
to the following page to find the cause of the problem. If a worn-out lens is the likely cause of the 
problem, replace the lens with a new one.

	" P.90  "The Imprinted Image is Unattractive (It Is Uneven or Shifted)"

	* Replacement lenses are sold separately. For purchasing information, contact your authorized Roland DG 

Corporation dealer or visit the DGSHAPE Corporation website (https://www.dgshape.com/).

	* For the lens replacement method, see the manual included with the replacement lens.

Replacing the Light-absorbing Film

If you use the same location multiple times, the light-absorbing effect will be reduced. Use the light-absorbing 
film by shifting its position so that unused locations are used. When there are no longer any unused locations, 
replace the light-absorbing film.

A General Guide for the Service Life of the Light-absorbing Film

The light-absorbing film has reached the end of its service life when it exhibits clear wrinkles and waviness due to 
the heat generation from repeated use or when it becomes white. When the light-absorbing film is in a state such 
as that shown in the following figure, shift its position or replace the light-absorbing film.

Parts that become white can no longer absorb light, 
which means that they cannot be used for imprinting. 

Replacing Consumable Parts
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Light-absorbing Film Replacement Method

Procedure

A	Remove the film frame from the table.

B	Orient the film frame so that the adhesive sheet surface faces up.

Adhesive sheet

C	Peel the light-absorbing film off the film frame.

Replacing Consumable Parts
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D	Affix a new light-absorbing film to the film frame.
Match the film to the shape of the film frame, ensuring that the film does not protrude outside the 
edges of the film frame.

Not  OKOK

Light-absorbing film

Important!

The light-absorbing film has a material side and a lens side. You can ensure that the film is affixed 
with the correct side facing up by matching the film to the shape of the film frame. Using the machine 
with the wrong side facing up may lead to malfunctions, so exercise caution when affixing the film.

Memo
If the adhesive force with which the adhesive sheet affixes to the film frame has been reduced, clean the adhesive 
sheet.

	" P.48  "Cleaning the Film Frame"
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Create the imprint data while checking the film frame's set position in the METAZAStudio window.

Procedure

A	Click .

The [Material] panel appears.

B	Select the shape of the film frame.

1	From [Group], select [Material].

2	Select [Icon].

3	Click [LD-300_FilmFrame].

4	 Click .

1

2

3

4

The [Material Size] screen appears.

Creating Data to Match the Film Frame
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5	Click [OK].
Do not change the settings. If you change something by mistake, return the settings to those 
shown below.

Width: 305 mm (12.01 in.)

Height: 230 mm (9.06 in.)

5

The film frame is displayed.

Creating Data to Match the Film Frame
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C	Click [File] → [Preferences].

The [Preferences] screen appears.

D	Set the margins.

1	Set [Margin] to 2 mm (0.08 in.).

2	Click [OK].

Creating Data to Match the Film Frame
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Keeping Only the Required Portion of an Image (Trimming)

METAZAStudio can cut an original image to remove unneeded areas and keep just the required portion.
This operation is called "trimming."

Procedure

A	Import the image.

	" P.34  "Step 2: Import the Image"

B	Select the image.

1	Click .

2	Click the image.

Eight trimming bars appear around the image.

C	Trim the image.
Drag the trimming bar to trim the area you want to keep.

Trimming pointer

Processing Images
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Adjusting the Location, Size, or Angle of an Image

Procedure

Click .

Adjusting the position of the image

1	Click the image.
(■) appear at the four corners of the image.

2	Drag the image to adjust its location.

Adjusting the size of the image

1	Click the image.
(■) appear at the four corners of the image.

2	Drag the handles at the four corners of the image to adjust the size.

Handle

Processing Images
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Adjusting the angle of the image

1	With the handles present at the four corners of the image, click the image a second time.
The shape of the handles at the four corners changes to (●).

2	Line up the pointer with a handle.
The shape changes to a pointer for rotation.

3	Drag the handle to adjust the angle of the image.

Memo

•	 Holding down the keyboard's SHIFT key as you drag a handle makes the angle change by 45 degrees at a 
time. Using this method can be convenient at times, such as when you want to perform rotation by precisely 
90 degrees.

•	 Trimming cannot be performed for an image whose angle has been changed. To perform trimming, first 
return the image to its original angle.

Processing Images
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Enclosing an Image in a Frame

You can change the arrangement of the imprint data by placing a frame around an image. You use frames 
registered in what's called METAZAStudio's "library." The library contains a number of preregistered frames, and 
you can register new ones.

	" METAZAStudio online help ("Hints and Tips" > "Making Use of Library")

Procedure

A	Click .
The [Library] window appears.

B	Insert a frame.

1	From [Group], select [Frame].

2	Select [Icon].

3	Click the [18] frame.

4	Click .
A frame is inserted into the window.

Processing Images
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C	Adjust the size and location of the frame.
When the size of the frame is smaller than that of the material, the result becomes as shown in the figure. 
The adjustment methods are the same as the methods for adjusting the location and size of an image.

	" P.59  "Adjusting the Location, Size, or Angle of an Image"

Handle

Processing Images
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Tips and Tricks for Text Layout

Changing the Location, Size, or Angle of Text

You can change the location, size, and angle of placed text just as with an image.

Procedure

A	Enter text.

	" P.36  "Step 3: Enter Text"

B	Adjust the text position.

1	Click .

2	Click the laid-out text.
Eight handles appear around the text.

3	Drag the text to adjust its location.

C	Adjust the size of the frame.
Drag the handles to adjust the size.
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D	Adjust the angle of the text.

1	Click on the text and hold down the mouse button until the shape of the handles at the 
4 corners changes to [●].

2	Line up the pointer with a handle.
The shape changes to a pointer for rotation.

3	Drag the handle to change the angle of the text.

Memo
Holding down the keyboard's SHIFT key as you drag a handle makes the angle change by 45 degrees at a time. 
Using this method can be convenient at times, such as when you want to perform rotation by precisely 90 degrees.

Arranging Text to a Fan Layout

A	Enter text.

	" P.36  "Step 3: Enter Text"

B	Click .
The [Properties] screen appears.

If the text box containing the entered characters is not selected, you cannot select . Be sure to 
select the text box.

Tips and Tricks for Text Layout
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C	Set the text placement.

1	Click the Format tab.

2	Select the [Align with Curve] check box.

3	Click [OK].

The layout of the text changes to a fan shape.

Tips and Tricks for Text Layout
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Laying Out Text along a Shape

Lay out text along a shape you have made using the drawing tools.

Procedure

A	Create a shape.

1	Click the drawing tool.
Use  in this example.

2	In the editing window, create a shape on the material.

	" METAZAStudio online help ("Commands" - "Toolbar Buttons")

Drawing tools

B	Click .
Position the pointer near the outline of the shape you created, and then click  when it appears 
under the pointer.

Tips and Tricks for Text Layout
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C	Enter text.

	" P.36  "Step 3: Enter Text"

The text is laid out along the shape.

Important!
Layout on an integrated polyline is not possible.

	" METAZAStudio online help ("Commands" > "[Object] menu" > "Convert to Polyline," "Integrate Polylines")

Filling Text

There are two ways to fill text: [Fill] and [Island Fill]. Select whichever method you desire.

Fill
Imprinting is performed without any spaces.

Island Fill
You can specify the interval between adjacent filling lines.

A	Enter text.

	" P.36  "Step 3: Enter Text"

Tips and Tricks for Text Layout
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B	Click .
The [Properties] screen appears.

If the text box containing the entered characters is not selected, you cannot select . Be sure to 
select the text box.

C	Configure the Fill settings

1	Click the [Fill and Contour] tab.

2	Select the [Fill] check box.

3	Select [Fill] or [Island Fill].
When you select [Island Fill], you need to enter the pitch* as well.

* Pitch: Interval between adjacent filling lines

4	Click [OK].
The text is filled.

Tips and Tricks for Text Layout
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About Stroke Characters and SFEdit2

What Are Stroke Characters?

Stroke characters are line drawings created by extracting the center lines from the base font.

What Is SFEdit2?

SFEdit2 is a program for creating and editing stroke character fonts. As all stroke characters are made up of 
polylines and lines, you can add or delete anchor points and add line segments. In METAZAStudio, you can use the 
stroke character fonts that are created and edited using SFEdit2.

Creating/Editing a Stroke Character Font
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SFEdit2 Window

No. Name Overview of function

1 Menu bar
Runs the various commands for SFEdit2.

	" SFEdit2 help ("Commands")

2 Toolbar
The toolbar is provided with buttons for running SFEdit2 commands such as 
[Open...] and [Save].

	" SFEdit2 help ("Commands" - "Toolbar buttons")

3 Status bar
Moving the pointer to a toolbar button or pointing to a menu command displays a 
brief explanation of the button or command.

4 Character list This displays the list of all stroke characters. To edit a stroke character, click it.

5 Base line
This is the reference line for lining up a text string horizontally. When text is 
written horizontally, the base lines of adjacent characters are lined up along a 
horizontal line so that there is no unevenness.

6 Text box
This is a box for enclosing text. The size of the box differs according to the type 
of base font and the character. Normally you should create the text so that it fits 
inside the box.

7 Base font text
This is displayed as a rough draft for editing stroke characters. A base font 
serves as the design base for a stroke character.

8
Stroke 
characters

These are line drawings created by extracting the center lines from the base 
font. All stroke characters can be edited by adding or deleting anchor points, 
adding line segments, and so on.

	" SFEdit2 help ("Operation Procedures" > "Step 2: Edit the shape of character")

Creating/Editing a Stroke Character Font
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Creating a Stroke Character Font

The method of creating and saving a stroke character font is explained below.

Procedure

A	Start METAZAStudio.

	"  See the setup guide for how to start the software.

B	Click [Edit] → [Stroke Font] → [Run SFEdit2…].
SFEdit2 starts.

C	Click [File] → [New…].
The [Select Base Font] screen appears.

D	Create the stroke character.

1	Select a font to be used as the base for the stroke character font to be created.

2	Click [OK].

Creating/Editing a Stroke Character Font
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A stroke character font is automatically created.

E	Click .

The [Save] screen appears.

F	Enter a name for the created stroke character font and save it.

1	Enter the name of the created stroke character.
Giving a name based on the base font name allows you to easily identify the new name later. For 
example, "MS P Gothic_SF" is entered.

2	Click [OK].

The created stroke character font is saved.

G	Click .

Creating/Editing a Stroke Character Font
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Changing Entered Characters into a Stroke Character Font

Make sure that either of the following operations is completed in advance.

Create a stroke character font before SFEdit2 is installed.

The window shown in the figure appears during installation. If you did not create a stroke character font at 

the time of installation, reinstall SFEdit2 and create a stroke character font.

	" P.93  "Installing the Software and the Electronic-format Manual Separately"

Create a new stroke character font.

	" P.71  "Creating a Stroke Character Font"

Procedure

A	Enter characters in METAZAStudio.

	" P.36  "Step 3: Enter Text"

B	Click .
The [Properties] screen appears.

If the text box containing the entered characters is not selected, you cannot select . Be sure to 
select the text box.

Creating/Editing a Stroke Character Font
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C	Select the stroke character font.

1	Click the [Format] tab.

2	Select [Stroke].
The options for [Font] become limited to stroke characters.

3	Select the stroke character font.

4	Click [OK].

Entered characters are changed into stroke characters. The stroke character font selected in 3 is 
used for the stroke characters.

Creating/Editing a Stroke Character Font
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Editing Stroke Characters

Procedure

A	Change an input character to a stroke character.

	" P.73  "Changing Entered Characters into a Stroke Character Font"

B	Begin stroke character editing.

1	Click .

2	Click the stroke character you want to edit.
Handles appear around the stroke character.

3	Click [Edit] → [Stroke Font] → [Edit Stroke…].

SFEdit2 starts.

C	From the Character List, click the stroke character you want to edit.
The stroke character you want to edit is displayed in the virtual body and the stroke character becomes 
editable. Change the position and shape of the stroke character.

	" SFEdit2 help ("Editing Polylines")

Character list

Creating/Editing a Stroke Character Font
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D	Close SFEdit2.

1	Click .
The selected stroke character font is overwritten with the edited details.

2	Click .
SFEdit2 closes.

The edited details are reflected in the stroke character.

Creating/Editing a Stroke Character Font
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Creating Variable Imprint Data

Imprinting a different object on each material after changing part of the imprint data is called "variable 
imprinting." When performing variable imprinting, you no longer need to create new data each time you load a 
material. You can continue to print different data without interruption.

Important!
Continuous imprinting with varying data can only be done with material that is the same composition and size.

A CSV file is required to perform variable imprinting.

You can create a CSV file using database files. For information on creating a CSV file, contact the administrator of 
the databases.

Step 1: Create a Variable Field

Memo: What is a variable field?
A variable field is a frame within which you can place text. With variable imprinting, data within the variable field 
is replaced with other data during imprinting.

Procedure

A	Start METAZAStudio.

	" See the setup guide for how to start the software.

If METAZAStudio is already running, click .

The [Select Foil] screen appears.

B	Use the [Select Foil] screen to select the foil.
Clear the [Use printer driver settings] check box to select the foil. To use foil that is not included in the 
list, you can register the foil.

	" P.82  "Registering the Foil and Adjusting the Imprinting Power"

If you will use the LD Driver settings without changing them, select the [Use printer driver settings] 
check box.

C	Click [OK].
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D	Click the Insert Frame icon.
Click  and then .

E	Drag the mouse (move it while holding down the left mouse button) diagonally downward 
on the work area* in METAZAStudio.
A variable field within which you can place text is created.

* Work area = black area on the screen

Work area

F	Click .
The [Properties] screen appears.

If the variable field is not selected, you cannot click . If you cannot click , click  and then 
click (select) the variable field.

Creating Variable Imprint Data
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G	Configure size and other such settings of the variable field.
For details on each setting, refer to the help for METAZAStudio ("Commands" > "[Object] menu" > 
"Properties" > "[Properties] dialog box").

	" See the setup guide for how to display the software's help.

H	After configuring the settings, click [OK].

I	Move the variable field to the imprinting position.

1	Click .

2	Drag the variable field to move it.

Creating Variable Imprint Data
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Step 2: Place Text Inside the Variable Field

Procedure

A	Click [Load CSV File].
The [Open...] screen appears.

If the [Variable Printing] window is not displayed, click .

B	Specify a CSV file and click [Open].

The specified CSV file is imported into METAZAStudio.

C	Drag the column title of the imported CSV file to the variable field.
Text is displayed in the variable field.

You can display each symbol in turn by clicking . If you want to change the size or location of 
the variable field, open the [Properties] screen (click ) and change the settings.

Creating Variable Imprint Data
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Adjusting the Imprinting Conditions

Adjusting the Imprinting Pressure

You change the position at which the lever is set to match the pressure that the head applies to the material 
during imprinting (the imprinting pressure).

•	

Set the lever to this position for the first imprinting performed on the material.

•	   or 

The larger the number, the greater the imprinting pressure applied to the material. Using a larger number 

results in the foil adhering to the material better than with the  setting. If clear imprinting was not 

performed with the  setting for soft material or material with a bumpy surface, try imprinting with the 

lever set to this position.

However, the higher the imprinting pressure, the greater the chance that imprinting marks will remain on 

the material and that the luster of the foil will be lost. Perform test imprinting on wood waste or a similar 

material to determine the appropriate imprinting pressure.

○ To raise: Simply lift up the lever.
○ To lower: Press the lever in slightly, then lower it.

Lever

81Chapter 4 Detailed Operations/Settings



Registering the Foil and Adjusting the Imprinting Power

With this machine, imprinting using an imprinting power that matches the foil of the material used makes it 
possible to obtain even higher quality imprint results. LD Driver has pre-configured settings that match a number 
of foils, but you can also register foils and their optimal settings. In order to obtain better imprint results, you can 
also carry out later adjustment of the imprinting power of foils you've registered yourself.

Procedure

A	Display the [LD Driver Printing Preferences] screen.

	" See the setup guide for how to display the [LD Driver Printing Preferences] screen.

B	Select the imprint mode.

1	Click the [Image Correction] tab.

2	Select an option for [Foil] (settings a through d).

3	Select [Text] or [Other] for the imprinting mode.

Text When you want to imprint text and other images with clear outlines

Other

Select this when you want to create an expression based on the difference 
of density of dots by changing the resolution capability (or the degree of 
dot resolution) or when you want to increase the resolution to improve the 
roughness of small text or patterns. Click [Details] to set the image resolution 
and other settings.

	" LD Driver online help ("[Image Correction] tab")

4	Click [Details].

The [Details] window appears.

Adjusting the Imprinting Conditions
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C	Configure the detailed imprint mode settings.

1	Enter a name for the foil you are registering.

2	Enter the speed and the imprinting power.
The imprint results vary according to the foil. Make adjustments to match the foil.

	" LD Driver online help ([Image Correction] tab > [Details] dialog box)

Speed
Change the imprinting speed. The speed of image (raster) imprinting and of line-
drawing imprinting will be the specified value. The upper limit of the imprinting 
speed is 48 mm/sec (1.89 in./sec).

Power--MIN Set the imprinting power of the darkest part of the image (the gray part).

Power--MAX Set the imprinting power of the brightest part of the image (the white part).

Vector--Power You can set the maximum value of the imprinting power for a line.

3	Select [Advanced].
[Advanced] is only available when [Other] is selected in 3 of Step B.

	" LD Driver online help ([Image Correction] tab > [Details] dialog box)

OutputResolution
You can specify the number of dots per inch. As the number of the points 
becomes larger, the image will become more precise.

Drafting
You can skip image information in increments of one dot in order to make 
images easier to see. With small text and lines, skipping information can lead to 
imprinting with noticeable roughness. In this situation, set this option to "OFF."

4	Click [OK].

The [Details] window closes.

Adjusting the Imprinting Conditions
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Changing Basic Driver Settings

Procedure

A	Display the printer icon.

Windows 11

1	Click the [Start] menu on the computer.

2	Click [All apps], [Windows Tools], and then click [Control Panel].

Windows 10

1	Click the [Start] menu on the computer.

2	Click [Windows System], and then click [Control Panel].

3	Click [View devices and printers].

B	Right-click the [DGSHAPE LD-300] icon, and then click [Printing preferences].
The LD Driver Printing Preferences window appears. Change the settings to suit your needs.

C	After configuring the settings, click [OK].
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Description

LD Driver allows you to configure the basic settings for a variety of items including the unit used for the display. 
The basic settings that have been configured with the methods previously described continue to be used.
You can also change these settings from METAZAStudio, but the changes will not be saved.

Procedure

Click [File] → [Print Setup] → [Properties].
The [DGSHAPE LD-300 Properties] window appears. Configure the settings to suit your needs.

Changing Basic Driver Settings
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Other Operations Available with METAZAStudio

METAZAStudio includes a variety of other functions.
For information on the operation method, refer to the online help for METAZAStudio.

	" P.10  "How to Display Help for the Software"
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Troubleshooting

The [Power/Movement] Button Is Blinking

Do you lift the head when you 
turn on the power?

Because the head is lifted to the topmost position, the machine 
determines that the surface height of the material does not meet 
the requirements for carrying out imprinting. Switch off the power by 
holding down the [Power/Movement] button for 1 second or longer.
When switching on the power, be careful not to touch the head 
unnecessarily.

Has the lens been attached to 
the machine correctly?

Switch off the power by holding down the [Power/Movement] 
button for 1 second or longer. For the correct method to use in 
attaching the lens to the machine, see the manual included with 
the replacement lens.

Is the change in the height of 
the imprint surface too large?

Switch off the power by holding down the [Power/Movement] 
button for 1 second or longer. Check the conditions of 
imprintable materials and select a material again.

P.17  "Preparing the Material"

Does the head reach the 
imprinting surface of the 
material?

Press the [Power/Movement] button to stop the lamp from 
blinking. Load the material correctly, using the material retainer 
that corresponds to the thickness of the material.

P.20  "Loading the Material (Material Thickness: 0 to 26 mm)"
P.22  "Loading the Material (Material Thickness: 24 to 50 mm)"
P.26  "Loading the Material (Material Thickness: 50 to 216 mm)"

The Machine Doesn't Run Even When Imprint Data Is Sent

Is the power switched on?
Make sure the Power/Movement button light is on. If it is dark, 
press the Power/Movement button to switch on the power.

P.9  "Switching On the Power"

Is the power cord connected 
correctly?

If it is not connected correctly, connect it properly.

See the setup guide for how to connect the main unit and the computer.

Is the cable used for the 
connection to the computer 
connected correctly?

Check if the connection cable is disconnected.

You Cannot Select the Foil Using METAZAStudio

Is the [Use printer driver 
settings] check box selected?

If the [Use printer driver settings] check box is selected in the 
[Select Foil] window displayed directly after METAZAStudio 
starts, you cannot select the foil. Clear the [Use printer driver 
settings] check box.

Are you using an older version 
of METAZAStudio?

Versions of METAZAStudio earlier than 2.43 do not support the 
LD-300, so you cannot select the foil. Install the latest version of 
METAZAStudio.

88 Chapter 5 Appendix



Materials and the Library Are Not Displayed in METAZAStudio

Has the software been installed 
correctly?

Install METAZAStudio and SFEdit2 again from the DGSHAPE 
Software Package CD included with the machine. Do not 
uninstall any software that is already installed, just install the 
software again.

P.93  "Installing the Software and the Electronic-format Manual 
Separately"

The Imprinted Location Isn't Where Desired

Are the laser pointer and the 
material loaded at the correct 
locations?

Check whether the material has been loaded correctly. Also, 
operate METAZAStudio to emit the laser pointer for positioning 
onto the material. Adjust the position of the imprint data in 
METAZAStudio as necessary.

P.20  "Loading the Material (Material Thickness: 0 to 26 mm)"
P.22  "Loading the Material (Material Thickness: 24 to 50 mm)"
P.26  "Loading the Material (Material Thickness: 50 to 216 mm)"
P.37  "Step 4: Match the Imprinting Position and Size"

The laser is irradiated on the 
target, but nothing is imprinted.

Does the material meet the requirements for imprinting with this 
machine?
Prepare and use imprintable material.

P.81  "Adjusting the Imprinting Conditions"
P.17  "Preparing the Material"

Is the irradiation position of the 
machine's laser pointer 
displaced?

Use LD-300 Head Manager to adjust the irradiation position of 
the laser pointer.

P.49  "Adjusting the Position of the Laser Pointer"

Has the light-absorbing film 
been installed with the incorrect 
side affixed to the frame?

Imprinting will not be performed if the incorrect side of the light-
absorbing film is affixed to the frame. When first installing the 
light-absorbing film and when replacing the light-absorbing film, 
attach it with the correct orientation.

P.51  "Replacing the Light-absorbing Film"

Are the front and back sides of 
the foil incorrect?

Place the foil on the material such that the glossy surface of the 
foil that you want to imprint faces up.

Troubleshooting
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The Imprinted Image is Unattractive (It Is Uneven or Shifted)

The imprinting pressure may 
not be appropriate.

A greater pressure is required to imprint on soft material or 
material that has microscopic indentations and protrusions on 
its surface. Increasing the imprinting pressure may improve the 
imprinting result. Set the lever to position  or , which are 
numbers that are larger than that of the lever's current position.
With hard material, reducing the imprinting pressure may 
improve the imprinting result. Set the lever to a position with a 
number smaller than that of the lever's current position.

P.81  "Adjusting the Imprinting Pressure"

Are the settings for the foil 
correct?

Choose the loaded foil in METAZAStudio.
Even if the foil is the same, the imprinting conditions vary 
depending on the surface status. In such cases, fine adjustment 
of the imprinting power is necessary.

P.82  "Registering the Foil and Adjusting the Imprinting Power"
P.32  "Step 1: Prepare to Create Imprint Data"

Has the lens reached the end 
of its service life?

You can check the state of the lens using LD-300 Head Manager.
If the indicator for the lens usage has reached the red part of the 
display, replace the lens with a new one.

P.50  "Checking the Lens Service Life"

Was bidirectional imprinting 
performed?

Bidirectional imprinting can shorten the imprint time, but the 
image quality may suffer. If this happens, go to the LD Driver 
setting window and clear the selection for [Bidirection], and then 
perform imprinting again.

LD Driver online help ("[Material] tab")

Are you performing imprinting 
repeatedly in the same location 
on the light-absorbing film?

If you use the same location multiple times on the light-absorbing 
film, you will not be able to imprint cleanly. If the film has both 
unused locations and locations that have been used multiple 
times, uneven imprinting may occur.
Shift the location being used on the light-absorbing film so that 
an unused location covers the imprint range, and then perform 
imprinting again.

P.51  "Replacing the Light-absorbing Film"

The Imprinted Image Is Always Missing at the Same Location

Is the change in the height of 
the imprint surface too large?

The change in the height of the imprint surface may be too large. 
Recheck the requirements for the material that can be imprinted 
by the machine and select a material that meets the requirements.

P.17  "Preparing the Material"

Are you performing imprinting 
repeatedly in the same location 
on the light-absorbing film?

If you use the same location multiple times on the light-absorbing 
film, you will not be able to imprint cleanly. Shift the location 
being used on the light-absorbing film so that an unused location 
covers the imprint range, and then perform imprinting again.

P.51  "Replacing the Light-absorbing Film"

Troubleshooting
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It Is Necessary to Remove the Unneeded Foil That Remains in Locations outside of the Imprinting Location

When foil remains in an unintended location, use cellophane tape to remove the unneeded foil.

Laser Pointer Position Adjustment Failed (Head Manager)

If an error screen is displayed and the failure still occurs even after you perform LP position adjustment from the 
beginning with LD-300 Head Manager, contact your authorized Roland DG Corporation dealer.

	" P.49  "Adjusting the Position of the Laser Pointer"

Installing the Driver Separately

You can install LD Driver and the software at the same time. To install all these items at the same time, see the 
setup guide.

Procedure

A	Log on to Windows as an administrator or as a member of the Administrators group.

B	Insert the DGSHAPE Software Package CD into the computer's CD-ROM drive.
When the automatic playback window appears, click [Run menu.exe]. If the [User Account Control] 
window appears, click [Allow] or [Yes]. The setup menu appears automatically.

C	Uninstall LD Driver if it has already been installed.

	" P.96  "Uninstalling the Driver"

Go to Step D if the driver is not installed or has been uninstalled.

D	Click [Custom Install].

Troubleshooting
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E	Click [Install] for LD Driver.

F	Select [Install], [DGSHAPE LD-300] for the model name, and [USB] for the port, and then 
click [Start].

The LD Driver installation starts. Proceed by following the on-screen instructions.

If the screen shown below appears during installation, click [Install].

G	When the screen shown here is displayed, click [Finish].

Troubleshooting
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H	Click  on the setup menu screen.

I	Remove the CD from the CD-ROM drive.

J	Connect the machine to the computer using the USB cable.
Use the included USB cable. Do not use a USB hub.

LD Driver is installed automatically.

Installing the Software and the Electronic-format Manual Separately

Procedure

A	Log on to Windows as an administrator or as a member of the Administrators group.

B	Insert the DGSHAPE Software Package CD into the computer's CD-ROM drive.
When the automatic playback window appears, click [Run menu.exe]. If the [User Account Control] 
window appears, click [Allow] or [Yes]. The setup menu appears automatically.

C	Click [Custom Install].

Troubleshooting
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D	Click [Install] for the software or electronic-format manual that you want to install.

For information about LD Driver installation, see P.91  "Installing the Driver Separately".

E	Follow the messages to install the software.
If a [User Account Control] window appears, click [Allow] or [Yes] to continue with the installation.

F	When installation finishes, click  on the setup menu screen.

G	Remove the CD from the CD-ROM drive.

Driver Installation Is Impossible

If installation quits partway through or if the wizard does not appear when you make the connection with a USB 
cable, LD Driver may not have been installed. In such cases, perform the following procedure. (If procedure A does 
not solve your problem, perform procedure B.)

Windows 11/10 (Procedure A)

Procedure

A	Connect the machine to the computer using the USB cable, and then switch on the power 
to the machine.

B	Click [Desktop].

C	Follow the procedures shown below to click [View devices and printers] (or [Devices and 
Printers]).

Windows 11

1	Click the [Start] menu on the computer.

2	Click [All apps], [Windows Tools], and then click [Control Panel].

3	Click [View devices and printers].

Troubleshooting
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Windows 10

1	Click the [Start] menu.

2	Click [Windows System], and then click [Control Panel].

3	Click [View devices and printers].

D	Check that the model you are using is displayed under "Unspecified."

E	Right-click the icon of the model you are using, and then click [Remove device].

F	When the message "Are you sure you want to remove this device?" is displayed, click [Yes].

G	Check that the icon for the model you are using is no longer displayed under "Unspecified."

H	Temporarily disconnect the USB cable connecting the machine to the computer, and then 
reconnect these devices. If the printer icon for the machine you are using is displayed 
under "Printer," the Windows driver has been successfully installed.

I	If this does not solve the problem, perform the procedure under "Windows 11/10 (Procedure B)."

Windows 11/10 (Procedure B)

Procedure

A	Connect the machine to the computer using the USB cable, and then switch on the power 
to the machine.

B	If the [Found New Hardware] window appears, click [Cancel] to close it. Disconnect any 
USB cables for printers other than this machine.

C	Click [Desktop].

D	Right-click the [Start] button, and then click [Device Manager].

E	If the [User Account Control] window appears, click [Continue]. [Device Manager] appears.

F	From the [View] menu, click [Show hidden devices].

G	In the list, find and double-click [Printers] or [Other devices]. Click the model name or 
[Unknown device], whichever appears below the item you selected.

H	From the [Action] menu, click [Uninstall] or [Uninstall device].

I	In the "Confirm Device Uninstall" window, click [OK]. Or, in the "Uninstall Device" window, 
click [Uninstall]. Close [Device Manager].

J	Detach the USB cable from the computer, and then restart Windows.

K	Uninstall the Windows driver. Carry out the steps from step 3 on P.96  "Windows 11/10" to 
uninstall the driver.

L	Reinstall the driver again according to the procedure in "Setup Guide" ("Installing the 
Software") or P.91  "Installing the Driver Separately".

Troubleshooting
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Uninstalling the Driver

To uninstall LD Driver, perform the following procedure.

Windows 11/10

Procedure

* �If the driver is uninstalled without following the procedure given below, there is a possibility that re-installation 
may not be possible.

A	Switch off the power to the machine, and then detach the connector cable between the 
machine and the computer.

B	Log on to Windows as an administrator.

C	Click [Desktop].

D	Follow the procedures shown below to click [Control Panel].

Windows 11

1	Click the [Start] menu on the computer.

2	Click [All apps], [Windows Tools], and then click [Control Panel].

Windows 10

1	Click the [Start] menu.

2	Click [Windows System], and then click [Control Panel].

E	Click [Uninstall a program].

F	Click the Windows driver for the machine to delete to select it, and then click [Uninstall]. If 
the [User Account Control] window appears, click [Allow] or [Yes].

G	If a message prompting you to confirm deletion appears, click [Yes].

H	Right-click [Start], and then click [Desktop].

I	Open Explorer, and then open the drive and folder containing the Windows driver. (*)

J	Double-click "SETUP64.EXE" (64-bit version) or "SETUP.EXE" (32-bit version).

K	If the [User Account Control] window appears, click [Allow] or [Yes]. The setup program 
for the Windows driver starts.

L	Click [Uninstall]. Select the machine to remove and click [Start].

M	If it is necessary to restart your computer, a window prompting you to restart will appear. 
Click [Yes].

N	After the computer has restarted, open Control Panel again, and then click [View devices 
and printers] or [Devices and Printers].

Troubleshooting
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O	If you can see the icon of the machine to remove, right-click it and click [Remove device].
(*)

When using the CD-ROM, specify the folder as shown below. (This is assuming your CD-ROM drive is the D drive.)

D: \Drivers\WINX64 (64-bit version)

D: \Drivers\WINX86 (32-bit version)

If you are not using the DGSHAPE Software Package CD, go to the DGSHAPE Corporation website 

(https://www.dgshape.com/) and download the Windows driver for the machine you want to remove, and 

then specify the folder where you want to extract the downloaded file.

Troubleshooting
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Moving the Machine

Important!
When moving the machine, be sure to carry out the removal/attachment procedures described below. Moving 
the machine without doing so may result in damage to the machine.

Avoid touching the rails while performing work

Needlessly touching the rails will remove their grease, leading to the rails rusting.

Rails

Step 1: Removing the Material Retainers from the Machine

Procedure

A	Make sure the power is switched off.

B	Unplug all cables, such as the power cord.

C	Remove all the material retainers other than the base table.
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Step 2: Attaching the Retainers to the Machine

Procedure

A	Remove retainers A, B, and C, which have been stored on the back of this machine.

Retainers B and C

Retainer A

B	Slowly move the head to the back and center.

C	Attach retainers B and C.

Hexagonal 
wrench (large)

Retainer B

Hexagonal 
wrench (large)

Retainer C

D	Slowly move the head to the left.
Be careful to avoid moving it with too much force.

Head

Moving the Machine
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E	Set the lock lever to .

F	While lifting the head up, attach retainer A.
Push retainer A from under the lever to fix the retainer in place. After fixing the retainer in place, check 
that the head does not move up and down.

Retainer A

Hexagonal 
wrench (large)

Lift the position indicated in the figure.

G	Close the cover of the machine.

H	Repack the machine.
When moving the machine, be sure to support it at the bottom using two hands. Attempting to move 
the machine by holding it at a different location may result in damage.

Moving the Machine
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Work Area

Base table

Unit: mm (inches)

363 (14.29)

267 
(10.51)

Raising table

Unit: mm (inches)

320 (12.60)

240 
(9.45)

Main Unit Specifications
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Material Retaining Frames

Unit: mm (inches)

281 
(11.06)

213 
(8.39)

Moving the Machine
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Imprint Area

Maximum Imprintable Area

Unit: mm (inches)

271 (10.67)

9.
5

(0
.3

7)
9.

5
(0

.3
7)

11.1 
(0.44)

11.1 
(0.44)

192 (7.56)

Film frame

Raising table

Base table

Laser movable area

Unit: mm (inches)

305 (12.01)

230 
(9.06)

Raising table

Base table

Moving the Machine
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Laser Pointer Irradiation Area

Unit: mm (inches)

265 (10.43)

230 
(9.06)

Base table

Locations of the Power Rating and Serial Number Labels

Back surface

AC adapter

Power Rating
Use an electrical outlet that meets the requirements 
for voltage, frequency, and amperage given here.

Serial number
This is required when you seek maintenance, 
servicing, or support. Never peel off the label or let it 
get dirty.

Power Rating
Use an electrical outlet that meets the requirements 
for voltage, frequency, and amperage given here.

Moving the Machine
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